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ScanPoint is an accessory software that is available to be used with Verathon Inc. 
instruments that have ScanPoint functionality. In combination with device connectivity 
software installed on a customer computer and an Internet connection, the site enables 
calibration, instrument performance monitoring, exam reporting and archiving service, 
and export of reports to customized 3rd party electronic health record (EHR) systems 
automatically or through manual download from ScanPoint and import to the EHR.

Statement of Intended Use
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Managing Exam Data 

The Exams Home Page

After logging in to ScanPoint, you will be presented with the Exam Home page.

The Exam Home page is divided into two areas:

The New Exams Panel – The 
center panel displays the most 
recent exams uploaded to 
ScanPoint.

The Navigation Panel – On 
the left side of the screen, lists 
the following options:

 • Review History – 
Review past exams, both 
annotated and unannotated.

 • Perform Exam – Available in Internet Explorer only. If QuickPrint is installed and 
running, this link will activate the QuickPrint software.

 • Calibration – Available in Internet Explorer only. If QuickPrint is installed and 
running, it will launch QuickPrint with the Calibration window open.

The Navigation Panel may also display the names and patient ID numbers from exams that 
have been annotated recently.  The display duration for recently annotated exams can be 
changed in the Site Preferences box on the My Accounts tab.

Three buttons are located in the upper right of the New Exams panel. They allow the 
following operations to be performed on one or several exams selected by a check in the 
far right column:

Print Report – Prints reports of selected exams

Export to PDF – Creates PDF report of exam for printing or saving electronically

Customer Care Review – Creates e-mail to Verathon Medical Customer Care

Please refer to the ScanPoint 3.0 Comprehensive User’s Manual for more information on 
these functions. See page 19 to access the Comprehensive User’s Manual online.

Open the ScanPoint® home page 
(https://my.scanpoint.com)

•	 Enter the user name and password provided to you 
by Verathon Medical.
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Exam data from AortaScan®, BladderScan and FloPoint® Elite instruments is uploaded to 
ScanPoint using the QuickPrint desktop communications utility.

NOTE: ScanPoint 3.0 requires QuickPrint version 1.6 or higher. Please contact Verathon 
Medical Customer Care if you need an upgraded version of QuickPrint.

Uploading Exams with QuickPrint

Uploading Exams with ActiveX Controls

NOTE: This section applies ONLY to users of BladderScan® BVI 6000 series instruments 
that DO NOT use the QuickPrint desktop utility to enable communications between their 
ScanPoint® Docking Station and their web-based ScanPoint account. All other users should 
skip this section and begin with Uploading Exams with QuickPrint.

ActiveX controls are distributed applications that work over the Internet through web 
browsers. Early versions of ScanPoint used ActiveX control to communicate between the 
instrument and the web-based ScanPoint account. More recent versions of ScanPoint use 
the QuickPrint desktop utility to enable this communication. 

The ScanPoint with ActiveX installer installs drivers for the ScanPoint docking station and 
pre-installs the ActiveX control. Users with the ActiveX control should be provided with 
sufficient privileges to install updates to the ActiveX control when necessary. The primary 
reason for updates is to renew the security certificate of the ActiveX control.

For instructions on connecting a Docking Station to the ScanPoint host computer, please 
review to the ScanPoint 3.0 Comprehensive User Manual (see page 19 for online access).

To upload patient data from a BVI 6000 series instrument to ScanPoint:

Fill in the requested information and click Submit.  

After performing an exam with 
your BladderScan BVI 6000 series 
instrument, place the instrument in 
its Docking Station connected to the 
ScanPoint host computer.

1

Login to ScanPoint. Open the Exams 
tab and select Perform Exam. The 
Patient Information page will open.  

2

3

When exam transmission is complete, the message Exam received successfully will 
appear. To review exam results, select Review History.4

For further information on using ActiveX controls, please consult the ScanPoint 3.0 
Comprehensive User’s Manual (see page 19) or contact Verathon Medical Customer Care.

Managing Exam Data 
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Uploading Exams from BladderScan® BVI 6000 Series and 
FloPoint® Elite Instruments

A

BladderScan 
BVI 6100

FloPoint Elite

NOTE: Unsaved exam data will be lost. If the handset battery is low or if the handset 
goes into sleep mode (after 20 continuous minutes of non-use), unsaved exam data will 
be lost.

Voice-annotated exams will upload directly to ScanPoint without 
requiring additional annotation. While the patient exam data is uploading 
to ScanPoint, the handset displays the percentage of data transferred.  

For more information on annotating exams in QuickPrint, please see 
page 12.

Place the BVI 9000 series instrument with saved exams onboard within 10 feet of the Battery 
Charger/Wireless Hub connected to your ScanPoint-enabled computer.

After performing an exam with your BladderScan BVI 6000 series 
or FloPoint Elite instrument, place the instrument in its Docking 
Station connected to the QuickPrint host computer.

Managing Exam Data 

1

QuickPrint will open automatically. If the instrument is holding 
patient exams that do not have a voice annotation, the Enter 
Exam Detail window will open. Complete the fields and click 
Submit to upload the exams to ScanPoint®.

2

3

Uploading Exams from BladderScan BVI 9000 Series and  
AortaScan® AMI 9700 Instruments

1

2 To open a wireless connection to ScanPoint, press    on the AortaScan or BladderScan 
instrument’s front panel.

B

BladderScan  
BVI 9400

AortaScan  
AMI 9700

BladderScan 
BVI 6400

BladderScan  
BVM 9500

BladderScan  
BVI 9600
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Managing Exam Data

Open QuickPrint on the computer and click Find New.  The 
instrument will take some time to synchronize with QuickPrint 
via the Wireless Hub. As the exams are uploading to 
ScanPoint® via QuickPrint, the instrument console displays a “transmitting” graphic.

3

4 Next time you log on to your online ScanPoint account, the exams will be ready for review. 

•	 Unannotated exams will be 
displayed in the New Exams 
panel on the Exam Home 
page.

•	 Annotated exams will be 
displayed in the New Exams 
panel and in the Navigation 
Panel on the left of the 
Exam Home page. The 
annotated exams will remain in the New Exams panel for the duration set in the Site 
Preferences box on the My Accounts tab.

•	 Both types of exams can also be found on the Review History page.

Annotating Exams

1

2

3

4

To open an unannotated exam report, click the instrument name, or the  or icon, 
of the desired exam on the Exam Home page.  

If a voice annotation was recorded, playback 
begins automatically.  

The Exam Results page displays the exam 
date and time, measurements, and images.

When the report is open, you may:

•	 Press or Play to replay the voice annotation.

•	 Annotate the exam by completing the fields for Patient ID, Patient Name, Operator, 
and Physician. Click Save to save your annotations.

After the exam is annotated, the patient’s name and ID number will appear in the 
Navigation Panel at the left side of the Exam Home page.

•	 Click Send to HL7 or Send to XDS if enabled (see pg. 17)

•	 Click Export to CDA/CDA (PDF) to export exam data (see pg. 17)

•	 Click Print to print the exam report

•	 Click Close to close the record without making any changes

BladderScan® Bladder Volume Exam Results
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Managing Exam Data

Reviewing Past Exams

To view a list of all exams performed by instruments in your 
account, click Review History at the top of the Navigation 
Panel.

The Exam Review History list 
includes:

•	 Type of exam performed

•	 Instrument operator

•	 Ordering physician

•	 Primary exam  
measurement

- Abdominal aortic diameter         
- Bladder wall mass (UEBW)
- Bladder volume
- Peak urinary flow

The Patient ID designator is a link to a list of all exams performed on that patient.

The information is listed chronologically by default. Click the column heading to re-sort the 
data. Each column heading has an adjacent Filter icon. Click this icon to perform a multi-
criteria search on selected data.

At the top of the Review History page, search fields are available for finding individual 
exams.

You can search for a particular exam, a particular patient’s exams, or exams performed by 
a particular operator or instrument.

•	 Available search fields are Patient ID, Patient Name, Instrument Serial Number, 
Operator, Exam ID, and Start and End Dates.

•	 “Wildcard” searching is allowed using an asterisk (*). Multiple asterisks are allowed.
 

1

2

Searching for Individual Records
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Managing Exam Data

Enter your search term(s) in the fields provided at the top of the page. Then hit Enter 

or click  

Use the filter option on each column header to select desired values in each column. Click 
to clear the entries.

Reviewing Patient History 

To update patient information:

•	 From the Exam Home or Review History or Patient 
History pages, select the desired Exam Type, click on the 

or icons, or click on the measurement. 

•	 Enter the new patient information

•	 Click Save at the bottom of the page to save changes and 
close the record

To view all exams for a particular patient:

•	 From the Review History page, click the Patient Name or Patient ID number

•	 Alternately, from the Navigation Panel, select a patient’s name

The Patient History page will open. This page 
has two sections:

Exam Record: Lists all exams performed on 
this patient in reverse chronological order.

Results Charts: Aggregated exam data of 
the same type, allowing clinicians to review 
progress of treatment over time. Four charts will 
be displayed:

•	 Post-void BladderScan® – Post-
void residual (PVR) bladder volume 
measurement, in milliliters (ml).

•	 BladderScan UEBW – Bladder wall mass 
measurement (UEBW), in grams (g).

•	 FloPoint® Elite – Peak flow, in milliliters 
per second (ml/s).

•	 AortaScan® – Abdominal aortic diameter, 
in centimeters (cm).

Updating Patient Information

NOTE: The Post-void BladderScan chart will only be populated with exam data if the 
bladder volume measurements were taken within 20 minutes after a FloPoint Elite exam, 
so that they are truly identified as post-void residual (PVR) bladder volume measurements. 
Pre-void bladder volume measurements are not aggregated into Results Charts, as they 
lack the utility of a PVR measurement for diagnosing conditions such as bladder outlet 
obstruction (BOO).

.

Typical Patient History page
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To view sample report formats for AortaScan®, 
BladderScan®, and FloPoint® Elite instruments, select 
Help>Report Type Samples from the QuickPrint 
menu bar.

You may also view sample reports by opening an 
exam in the Exam Home, Review History or 
Patient History pages, clicking the Print button, 
selecting Cancel for the Print window that appears, 
then using the pull-down menu in the upper right 
corner of the Exam Report Print page to review 
available report options.

Exam images generated by BladderScan BVI 6000 series 
and BVI 9000 series instruments feature orientation icons to 
assist image interpretation.

The circled image represents the instrument Probe: 
The circle is the transducer (black rounded end), and 
the rectangle is the handgrip. The white dot in the icon 
corresponds to the dot displayed at the upper left of the scan 
image.

All BladderScan bladder volume and bladder mass measurements should be taken with 
the Probe held perpendicular to the patient’s spine, with the handgrip pointing to the 
patient’s right side. AortaScan measurements are taken with the Probe parallel to the 
spine, placed on the midline of the abdomen.

Assuming correct orientation of the Probe during a bladder volume measurement:

•	 Indicates that the scan was taken in the sagittal plane, with the left side 
of the image toward the patient’s feet

•	 Indicates the scan was taken in the transverse plane, with the left side 
of the image toward the patient’s right side

Interpreting AortaScan, BladderScan and FloPoint Elite Reports

Viewing Sample Report Formats

Managing Exam Data

Interpreting BladderScan Images

The patient data gathered from AortaScan, BladderScan, and FloPoint Elite 
instruments can be presented in several different report formats to highlight particular 
measurements, based on the clinician’s needs. Available report formats are:

•	 AortaScan Aortic Diameter Reports – Standard (summary)

•	 BladderScan Bladder Volume Reports – Standard (summary), Physician’s Office 
(detailed), and Extended Care Facility (detailed)
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Physician Signature: __________________________________________ 

BladderScan® Results 0570-0212 | 00009405 | 86133

Exam Date & Time: 4/14/10 2:02 PM
Patient ID: 
Patient Name: 
Operator: 
Physician: 

Urine Volume: 211ml

Gender:

Page	1 of	1Exam	Report	Print	-	ScanPoint®	3	by	Verathon®

4/16/2010https://10.112.4.130/ExamReportPrint.aspx?examId=86133

Interpreting BladderScan Bladder Assessment Kit Reports

•	 BladderScan® UEBW Reports – Standard (summary)

•	 FloPoint® Elite Reports – Summary and Detailed

FloPoint® Elite Summary 0570-0175 | 00001222 | 85821

Exam Date & Time: 3/23/10 5:20 PM
Patient ID: Test 2
Patient Name: Test 2
Operator: Test 2
Physician: Test 2

Gender: Male
Normal Void for Patient: Yes
Position: Standing

Peak Flow: 17.8 ml/s

Physician Signature :__________________________ 

Page	1 of	1Exam	Report	Print	-	ScanPoint®	3	by	Verathon®

4/16/2010https://10.112.4.130/ExamReportPrint.aspx?examId=85821

BladderScan Bladder Volume Standard Report FloPoint Elite Summary Report

The BladderScan Bladder Assessment 
Kit report combines data from the 
following exams performed within 20 
minutes of each other:

•	 A BladderScan exam or 
BladderScan UEBW exam to 
assess pre-void bladder volume 
and/or bladder wall mass and 
thickness

•	 A FloPoint Elite exam to assess 
urinary flow

•	 A BladderScan exam to assess 
post-void residual (PVR) volume

Measurement labels are grouped 
together in the order in which the 
exams are performed.

Bladder Assessment Kit reports are 
created by selecting the desired 
exams on the review history page 
and then clicking the        icon.

Bladder Assessment Kit Report
0570-0207 | 00000003 | 85901

0570-0175 | 00001222 | 85956

0570-0190 | 00009404 | 85949

Exam Date 3/24/2010 10:22 AM
Patient ID 100406-32
Patient Name W. Boehme
Operator
Physician
Gender 0
Ultrasound Estimated Bladder Weight43 ±1.6g
Peak Flow 35.3ml/s
Urine Volume 70ml

Average Flow 25.4ml/s
Time to Peak Flow 3.6s
Voided Volume 209ml
Flow Time 8.2s
Pattern Continuous
Void Time 8.2s
Gender
Normal Void for Patient
Position

Comments:
Procedure Code:

Managing Exam Data

BladderScan Bladder Assessment Kit Report
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To Open QuickPrint

•	 Double-click the   icon in your system tray

•	 Double-click the ScanPoint icon on your desktop

•	 Open the Start Menu and select: Programs>Verathon>ScanPoint 
QuickPrint>ScanPoint QuickPrint

QuickPrint stays in the background and becomes active when a BladderScan BVI 6000 
series or FloPoint Elite instrument is placed in its Docking Station (the Docking Station 
must be connected to the computer’s USB port):

•	 Voice-annotated exams will begin downloading automatically – see page 2 for details

•	 Unannotated exams will prompt you for annotation

For BVI 9000 series or AortaScan AMI 9700 instruments, QuickPrint must be opened 
manually.  To upload exam data, follow the data upload instructions on page 3.

A maximum of four Docking Stations (BladderScan BVI 6000 series and FloPoint Elite) and 
one Battery Charger/Wireless Hub (BladderScan BVI 9000 series and AortaScan AMI 9700) 
can be connected to the QuickPrint host computer at one time.

QuickPrint is a desktop utility that manages communication between your AortaScan®, 
BladderScan®, and FloPoint® Elite instruments and your online ScanPoint® account. 

QuickPrint starts automatically every time your computer is activated. You can verify that 
QuickPrint is running by confirming the presence of the ScanPoint icon in your system tray 
in the lower right corner of your screen, near the clock.

NOTE:  Using QuickPrint requires an active Internet connection.
    

Understanding the QuickPrint Main Window

The QuickPrint main window 
provides immediate access to the 
status of any Verathon instrument 
connected to the computer via 
docking stations or wireless hub.

•	 In the QuickPrint main 
window, the currently active 
instrument is indicated by 
a solid border around the 
status icon.

•	 To communicate with a 
different device, click the 
instrument’s status icon to 
make it active.

Using the QuickPrint Communication Utility

QuickPrint Main Window
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Using the QuickPrint Communication Utility

QuickPrint Main Window Controls

Item Meaning

ScanPoint® Button: Click to open a connection to your 
online ScanPoint account.

Calibrate Button: Click to begin calibrating the 
currently active instrument.

Status Indicator: 
Possible symbols are:

• Blue exclamation point: QuickPrint is waiting  
for you to input information.

• Green checkmark: The instrument is ready to use.

• Red stop sign: The instrument is performing 
a process such as transmitting information to  
ScanPoint. Do NOT remove the instrument from 
the Docking Station or interrupt the wireless 
connection.

Progress Bar: Indicates degree of completion of the 
current process.

Instrument Image: A picture of the instrument that is 
currently communicating with ScanPoint.

Instrument Name: The serial number or name 
assigned to the instrument. You can rename the 
instrument by clicking on the name and entering a new 
one.

Change Configuration Button (AMI 9700 and BVI 
9000 series only): Click to open a configuration dialog 
box that allows you to change settings for language, 
clinic name, and time and date format. For BVI 9000 
instruments only, you can also change UTI rates, 
catheter cost and volume, and currency displayed. 
You can also resynchronize the instrument clock to the 
computer clock.

Update Instrument Button (AMI 9700 and BVI 9000 
series only): Click to download the most recent software 
update for your instrument.

Find New Button: Click to locate and install new 
instruments.

Message Indicator: The envelope icon indicates the 
number of ScanPoint messages you have waiting to be 
viewed. To view your messages, click the icon.
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QuickPrint Menu Bar

Menu Item Tasks

File Print Last Exam: Prints last exam.

Close: Closes the active exam record.

Exit: Closes the QuickPrint program.

View Instrument Details: View default settings, calibration date, 
serial number, and other device information.

Find New Instruments: Search for and connect new 
AortaScan®, BladderScan®, or FloPoint® Elite instruments to the 
ScanPoint® host computer.

Launch ScanPoint: Opens your online ScanPoint account.

Application Log: Opens a table listing the history of events 
performed during QuickPrint use. (For Verathon Medical 
technical support only—no patient health information listed.)

Tools Preferences: Provides easy access to all user-configurable 
settings.

Preferences Wizard: Provides step-by-step instructions for 
customizing the major user-configurable settings for QuickPrint.

System Diagnostics: Tool for checking functioning of 
QuickPrint, including wireless connectivity with BVI 9000 series 
instruments.

Check for Updates: Check for any available software updates 
for AortaScan, BladderScan, or FloPoint Elite instruments and 
the QuickPrint desktop utility.

Calibrate Instrument: Enables calibration of BladderScan BVI 
6000, BVI 9000 and FloPoint Elite instruments.  Please refer to 
appropriate product manuals for additional required equipment.

Help ScanPoint with QuickPrint Help: Access ScanPoint with 
QuickPrint Help function.

Contact Information: Opens Web link to Verathon Medical 
contact information.

Report Type Samples: Contains examples of the various exam 
reports available in ScanPoint with QuickPrint.

Security Best Practices: Patient Privacy and ScanPoint with 
QuickPrint guidelines.

Privacy Agreement: The Verathon Inc. Privacy Agreement.

About: ScanPoint with QuickPrint system information, 
copyrights, and patents.

Using the QuickPrint Communication Utility
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Accessing Your Online ScanPoint Account from QuickPrint

From the QuickPrint main window, click 

Alternatively, from the QuickPrint menu bar, select View>Launch ScanPoint®

Annotating Exams in QuickPrint

Exams Without Voice Annotation 

If the AortaScan®, BladderScan®, or FloPoint® Elite instrument connected to the QuickPrint 
host computer is holding patient exams that do not have voice annotation, the Enter 
Exam Detail window will open.

To upload the exams to ScanPoint, complete 
the fields and click Submit.

To review or print the exams, open the Exam 
Home page in your ScanPoint account on the 
web. The exams will be listed in the Navigation 
panel on the left and in the Review History 
page.

Exams with Voice Annotation

Voice-annotated exams are uploaded directly to 
ScanPoint.

To add annotations such as Operator, Physician, 
Patient Name and Patient ID, or to review 
and print the exam, open the Exam Home or 
Review Exams page in your online ScanPoint 
account. The exams with incomplete details will 
be listed in the New Exams panel at the center 
of the Exam Home page.

Exiting QuickPrint

•	 If the QuickPrint main window is currently displayed, go to the File menu and  
select Exit 

•	 If the QuickPrint main window is not currently displayed, right-click the ScanPoint 
icon in the system tray and select Exit.

Enter Exam Detail Window

Using the QuickPrint Communication Utility
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Account Setup and Password Management

Setting Up a New ScanPoint Account

Open the ScanPoint® home page 
(https://my.scanpoint.com)

•	 Enter the user name and password provided 
to you by Verathon Medical or by your account 
administrator.

•	 If a user name and password aren’t provided, create 
them by clicking Create a Login.

1

2

3

The Create Login page will open. Complete all required 
fields (marked with a *). Click Continue.

The Security Questions page will open. Respond to 
the default questions, or use the drop-down menus to 
select a different question or to create a custom question.

Make sure your answers are easy to remember, or make a 
note of the questions selected and your answers to them. 
If you ever need to reset your password, you will be asked 
to answer two security questions, and the answers must 
match EXACTLY the answers given here (answers are 
case-sensitive).

If you forget your security question answers, you will 
need to contact Verathon Medical Customer Care or your 
local Verathon subsidiary to have your account-access 
privileges restored. These precautions are necessary to protect  
unauthorized access to patient data.

When the Security Questions page is complete, click Verify to move to the next screen, or 
Cancel to clear your answers and start over.

NOTE

NOTE

4 The prompt “Login successfully created. You will get an e-mail notification” 
appears. Click To Log On to complete your login. You have 48 hours to complete this 
process.

You will be returned to the ScanPoint home page. 
After receiving your confirmation e-mail from your 
account administrator, use your new user name and 
password to log on to your ScanPoint account.

After you log on, you will be prompted to change your 
password.

5

6 Proceed to Understanding Account Roles and Joining a Team (pg. 15).



15

Account Setup and Password Management

Recovering or Resetting Your Password

1

2

3

If you forget your password:

From the ScanPoint® home page, click Help.  At the bottom of the screen, select the 
Reset password link.

The Reset Password page will open. Type in either 
your login name or e-mail address and click Request 
Password Reset.

ScanPoint will send you an e-mail message with a 
password restore link. Click the link to open a page with 
two security questions.

Answer the questions and click Verify.

If your answers to the questions match those stored in the ScanPoint database, you will be 
directed to a page where you may set a new password. If the answers are incorrect, you 
will need to contact Verathon Medical Customer Care or your local Verathon subsidiary to 
reset your password. If you don’t have security questions and answers, contact Verathon 
Medical Customer Care or your local Verathon subsidiary for a password reset.

1

2

3

Enter your login name and password in the appropriate 
fields and click Login.

Your My Account page will open, displaying your name 
and contact information.

    

Select the Change Password link from the Navigation 
Panel on the left, or in the My Personal Information 
section.  The Change Password page will open.

In the Old Password field, enter the old password 
or the temporary password provided by your account 
administrator.

Changing Your Password

In the New password field, enter a new password.  Enter the new password again 
in the Confirm password field.

After completing the form, click Change Password.  The 
ScanPoint home page will open.

To open your account, enter your user name and new 
password, and click Login.



16

Account Setup and Password Management

Understanding Account Roles

Users access ScanPoint® via a secure account with specific role-based privileges and 
restrictions. User roles are Clinical (C), Technical (T), Administrator (A), Document Security 
Officer (S), and Patient Administrative (P).

Clinical: A clinical account typically belongs to a doctor, 
nurse, or other clinician who actually performs and 
annotates patient exams.  

Clinical users are assigned to teams with other clinical 
users defined by instrument part number and serial 
number.  

Clinical users have access to all patient data associated 
with the instruments they are authorized to use.

The default home page for Clinical users is the Exam 
Home page.

Technical: Technical accounts belong to the 
biotechnical or biomedical staff responsible for 
maintaining the instruments, including:  

•	 Performing or scheduling instrument calibrations

•	 Management of software upgrades, installations, 
and configuration changes

•	 Management of instrument service  
(warranty) plans

Technical users cannot access patient data.

The default home page for Technical users is the My 
Instruments page.

 

Administrator: Account Administrators handle 
management of user accounts, including:

•	 Adding members to teams

•	 Authorizing/deactivating user accounts

•	 Assigning user roles

•	 Enabling/disabling user team and  
instrument assignments

The default home page for Administrators is the  
My Accounts page.

Document Security Officer (DSO): The Document Security Officer is responsible for 
managing the security and integrity of patient data in exchanges between ScanPoint and 
third-party Electronic Health Record (EHR) systems. The DSO can also review audit logs to 
track activity and account usage.
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Account Setup and Password Management

Joining a Team

Patient Administrative: Patient Administrative users are specialist users who add patient 
demographic information to existing patient records to correct EHR transfer errors.

For more information on the capabilities of the DSO and Patient Administrative users, 
please refer to the ScanPoint® 3.0 Comprehensive User’s Manual. See page 19 for online 
access to the Comprehensive User’s Manual.

All ScanPoint users may request membership in instrument teams. These teams may 
include only a few people, or extend to an entire department or ward. Users are assigned 
to instrument teams by their account administrator or through a request to Verathon 
Medical Customer Care. Opening the My Account page allows users to view their team 
membership status.

Users can view instruments to which they’re assigned by opening their My Instruments 
page.

To join a team:

1

2

3

4

After logging in to your ScanPoint 
account, please select the My 
Account tab at the top of the page.

On the My Account page, find the My 
Teams area on the upper right. Click 
Join Another Team. When the box 
appears, enter the serial number of 
the instrument with which you want to 
be associated. The instrument serial 
number may be found on the label on 
the bottom of the instrument.  

The Request Membership page 
appears. Select the team you wish 
to join and the type of membership 
(Clinical, Technical, Administrator, 
DSO, Patient Administrative) you wish 
to request.

Please add a brief note to the Team 
Administrator explaining why you are 
requesting membership to the team 
and click Subscribe.

The Team Administrator will approve or disapprove the request and notify you by e-mail.
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Uploading Exam Data to Electronic Health Record (EHR) Systems

ScanPoint® 3.0 incorporates three different methods for uploading patient exam data to 
electronic health record (EHR) systems. The method you will use will depend on how your 
IT administrator has configured the interface between ScanPoint and the EHR system. The 
three methods are:

• Export to CDA/
CDA (PDF)

These buttons allow a Clinical Document Architecture (CDA) file to be opened 
or saved on the user’s computer. These files may then be imported to many 
EHR systems. Care must be taken to secure the document while it is saved on 
the user’s computer (the transmission of the document from ScanPoint to the 
user’s computer is secure).

The files are in the HITSP/C32 Continuity of Care Document (CCD) format. 
Export to CDA provides the measurements relating to the exam in text format. 
The codings for measurements are defined in the team’s EHR settings. The 
CDA (PDF) button will export the PDF exam report embedded in the HITSP/
C32 CCD format.

• Send to HL7 This method exports or re-exports a Health Level 7 (HL7) unsolicited 
observation to your EHR system through a custom Web service interface to 
manage authentication.

NOTE: This option will only appear if your IT staff has enabled HL7 export for 
your team.

• Send to XDS This method implements the IHE Cross-Enterprise Document Source where 
the HITSP/C32 CCD is stored in PDF format in a customer’s Document 
Repository and Document Registry.

NOTE: This option will only appear if your IT staff has enabled HL7 export for 
your team.  See the ScanPoint 3.0 Comprehensive User’s Manual for more 
information.

Configuration of the HL7 and XDS export functions is done by your IT department. The 
settings must be entered, saved, tested, and applied to your organization’s exams for 
export to occur.  

NOTE: It is the responsibility of the customer’s organization to configure and test 
the settings before applying the settings to a team.

Any exam annotated in the ScanPoint Web site after the export settings are applied to the 
team will automatically be exported. Any exam can be manually configured for export by 
clicking the Send to HL7 or Send to XDS buttons in the Exam Results page.

1

Configuring an Exam for Export

From the Exams Home, Review 
History, or Patient History pages, select 
the exam you wish to export and click on 

the icon to open the exam.
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2 When the exam opens, the Exam Results 
page is displayed.
 
Buttons at the bottom of the page activate 
the manual exam data export methods 
discussed previously:

•	 Export to CDA/CDA (PDF)

•	 Send to HL7 (requires IT 
implementation)

•	 Send to XDS (requires IT 
implementation)

3

Export to CDA/CDA (PDF)

Choosing either Export to CDA or CDA (PDF) 
creates an XML file. This file should be saved to the 
user’s computer and transferred manually to the 
EHR system. 

NOTE: The user is responsible for ensuring 
that any handling of the documents complies 
with his or her organization’s security policies 
and with local security regulations.

Uploading Exam Data to Electronic Health Record (EHR) Systems
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If you need help understanding how to use ScanPoint® or need assistance with exam 
results, there are a number of resources built into ScanPoint that can assist you:

 The Help button accesses the ScanPoint 3.0 Comprehensive User Manual, a 
searchable, bookmarked PDF document with detailed information on ScanPoint 
features and functions for all ScanPoint users, including Clinical users, Technical 
users, Administrators, Document Security Officers, and Patient Administrative 
users.

This capability may also be accessed from the QuickPrint main window by selecting 
Help>ScanPoint QuickPrint Help.

The Customer Care Review button creates an e-mail message to Verathon 
Medical Customer Care. To use:

Accessing the Help Function and Exiting ScanPoint

Accessing ScanPoint Help

NOTE: The e-mail will remove all patient identification data from the exam 
report to preserve patient confidentiality.

Contact via Phone: From the QuickPrint main window, select Help > Contact 
Information to find phone numbers for Verathon Medical Customer Care in your 
market. You may also get assistance with login issues by clicking Contact Customer 
Care from the ScanPoint home page.

• Select the exam report you want to review with Verathon Medical Customer Care 
by clicking the check box in the rightmost column.

• Click the  button to create an e-mail for Verathon Medical Customer Care.

• Enter your comments regarding the exam data in question.

• Click Submit.

You can logout of ScanPoint by the following actions:

 The Logout button logs you out and returns you to the ScanPoint home page.

Exiting ScanPoint
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